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Introduction 
There is an increased recognition that effectively visualizing data is 

important to anyone who works with and analyzes data. To that 

end, there has been an explosion in data analysis and data 

visualization tools over the past few years. For many people, 

however, Microsoft Excel continues to the be the workhorse for 

their data visualization needs. If you are an Excel user, the default 

chart types in do not need to limit your data visualization 

capabilities; extending the tool to create other chart types is indeed 

possible. 

In this step-by-step guide to data visualization in Excel, you will 

learn how to create nearly 20 new graphs in Excel 2016/Office 365 

(O365). Each tutorial will lead you through the steps to create each 

chart type (instructions and images use the 2016 version of Excel on 

PCs, but are very similar to those on the Mac). Some basic, working 

knowledge of Excel, how to create basic graphs, adding different 

data series, and combining graph types will be useful. There are 

certainly different strategies to creating some of these graphs, but 

the approach I present here allow you to not only create those 

graphs, but also give you the techniques you can use elsewhere to 

create your own graphs. Along with this guide you will also receive 

an Excel file that you can use to recreate the graphs on your own or 

to use as templates for your own work. 

Should you have questions or need clarifications, please contact me 

using the Contact form at PolicyViz.com 

(https://policyviz.com/about/contact/).  

Thanks, 

Jon Schwabish 
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Basic Data Visualization Principles 
This guide is not intended to be an introductory guide to best 

practices in data visualization. Instead, it is intended to show you 

how to extend the capabilities of Microsoft Excel so that you can 

create more and better visualizations. Yet, three basic principles 

seem especially useful to guide your creation of better, more effective 

visualizations. 

1. Show the Data 
People read will read the graphs in your report, article, or blog post 

to better understand your argument. The data are the most 

important part of the graph and should be presented in the clearest 

way possible. But that does not mean that all of the data must be 

shown—indeed, many graphs show too much. 

2. Reduce the Clutter 
Cart clutter, the use of unnecessary or distracting visual elements, 

tends to reduce effectiveness of the graph. Clutter comes in many 

forms: dark or heavy gridlines; unnecessary tick marks, labels, or text; 

unnecessary icons or pictures; ornamental shading and gradients; 

and unnecessary dimensions. Too many graphs use textured or filled 

gradients when simple shades of a color can accomplish the same 

task.  

3. Integrate the Text and the Graph 
As a first, simple step, legends that define or explain a series on a 

graph are often placed far away from the content—off to the right or 

below the graph. Integrated legends—either right below the title or 

directly on the chart—are more accessible.  

These three principles embody the idea that the graph creator should 

support the reader’s acquisition of information quickly and easily. By 

stripping out unnecessary clutter and emphasizing the data, your 

graphs can more clearly and more effectively communicate 

information. However, default graph options in many graphing and 

statistical programs tend to add clutter and to separate text and 

graphs.  
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Chart Tools Quick Tour  

This guide will help you change many of those defaults in Excel 

2016/O365, so a quick tour through the basic graph layout options 

seems appropriate. The Excel graphing engine is quite powerful and 

allows you to control a wide variety of formatting options for your 

graphs. That being said, the goal of this step-by-step guide is to give 

you the tools and strategies for pushing past the standard graph 

types.  
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Design Tab 

Once you’ve created a graph and selected it, a Chart Tools tab will 

appear at the top of your ribbon consisting of two tabs: Design and 

Format. The Design tab contains options that allow you to apply 

different default ‘Chart Layouts’ and ‘Chart Styles’. The options 

available under the ‘Add Chart Element’ button replaces the Layout 

tab on previous versions of Excel and allows you to modify the 

appearance of axes, titles, gridlines, and more. 
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Each of the options in the ‘Add Chart Element’ menu allows you to choose 

from a set of pre-populated options, or to open a menu with more options. 

The image at left shows the options available under the Axes button—here, 

I will usually select the “More Axis Options” to offer as many options as 

possible. 
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For purposes of this guide, the ‘Change Chart Type’ button 

(second-to-last button on the right) and the ‘Switch 

Row/Column’ button (fourth-to-last button on the right) will be 

used regularly. The ‘Change Chart Type’ button will allow you to 

change the type of chart for all the data on the chart, or a 

selected series. One of the new features in Excel 2016/O365 is the 

series of dropdown menus in this menu that allows you to 

change the chart type for each series within a single menu. In 

previous versions of Excel, you would need to do this one series 

at a time. 
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Format Tab 

The Format tab contains the standard outline and fill color options. There is also a Size section of the menu from which you can select 

the size of your graph. 
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 In the very top-left section of the Format tab is the ‘Chart Elements’ drop-down menu. 

The list in this drop-down menu consists of everything in your chart including titles, axes, 

error bars, and every series. If you have a lot of objects on your chart, this drop-down 

menu will help you to easily find and select what you need. 
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Chart Elements Menu 

One of the new features in Excel 2016/O365 is the ‘Chart Elements 

Menu’ that appears just outside the top-right part of the chart when 

you select it. Appearing as a ‘plus’ symbol, the menu is identical to 

the ‘Add Chart Elements’ button in the Design tab. 

Selecting the options will bring up a menu that will appear in a 

vertical banner along the right-edge of the window. From here, you 

can modify the appearance of different chart elements. 
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A couple of new features in Excel 2016 are worth mentioning. First, 

you can now select a specific data range to use as labels in your 

chart. This comes in quite handy when, for example, you want to 

add custom labels to a scatterplot. Instead of having to do the 

labeling manually, you can select the data labels series in the 

spreadsheet. 

Second, Excel 2016 has a larger (and growing) charting library, 

accessed in the “Recommend Charts” area of the Charts tab. Among 

the new chart types is a Treemap, Histogram, Box & Whisker, and 

Waterfall chart. It should be noted, however, that not all of these 

chart types are available on the version of Excel 2016 available on 

the Mac. 
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Overlaid Gridlines 
The Overlaid Gridline chart is a column chart with gridlines on top 

of the columns. This type of chart allows viewers to absorb the 

column data as segments rather than single columns. Use the 

OverlaidGridline tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. Begin by creating a column chart from columns A (“Group”) 

and B (“Main Series”). 
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2. Remove the title. 
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3. We’re now going to add the four “Line” series to the chart. 

There are a few ways to do so. If you select the chart itself, you’ll 

notice that the data are highlighted in the worksheet. You can 

simply select the little blue square at the bottom of the cells  

that are highlighted in blue and drag across. Alternatively, you can 

right-click on the chart and choose the “Select Data” option to add 

these series one at a time. We’ll start by just adding the data in rows 

2 through 6; the data in rows 7-11 will come later. 
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4. You will now have a clustered column 

chart, five series for each group. Select the 

orange series for “Line 5” on the graph. 

Under the “Design” tab under “Type” in 

the ribbon, select “Change Chart Type” 

(the third menu from the right). You can 

now use the dropdown menus to change 

the graph type for each series. Change the 

Chart Type for each “Line” series to “Line” 

and press “OK.” 
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Each series except the “Main Series” now become lines.  
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5. If we were to simply change the 

lines to white, they would end in 

the middle of the bars of the A and 

E groups. We now move each of 

those four lines to the “secondary 

axis” so we can get them to stretch 

through the bars. To do so, first 

select a line, right-click, and select 

“Format Data Series” (alternatively, 

use the CTRL-1 keyboard shortcut). 

Go to the “Series Options” tab and 

select the “Secondary Axis” option. 
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6. You’ll notice that a new y-axis has appeared on 

the right side of the graph. When you’re done 

moving all four series to the secondary axis, this 

new y-axis should go from 0 to 25 (if not, adjust 

the y-axes to be the same by selecting the axis 

and right-clicking or using the CTRL-1 

keyboard shortcut). 
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7. There is also now a secondary x-axis, but we need to turn it on. To 

do so, select the “Axes” option in the “Chart Elements” menu by 

pressing the “plus” button that will appear when you select the 

chart. By hovering over the “Axes” menu, three of the boxes will 

have checkmarks next to them (“Primary Horizontal”, “Primary 

Vertical”, and “Secondary Vertical”). Turn on the “Secondary 

Horizontal” axis by selecting the checkbox.
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8. Change the colors of the lines to white using the 

“Format” tab option. And notice that the lines 

still end in the middle of the bars for the A and 

E groups. 
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9. We fix that by changing how the data points line up with 

the tick marks. In a default line graph in Excel, the data 

markers line up between the tick marks; notice how the line 

begins in the middle of the A bar, between the y-axis and 

the tick mark between the A and B groups. By placing the 

data markers on the tick marks, we can extend the lines 

through the bars.  

To do so, we’ll format the secondary x-axis (by right-

clicking and navigating to the “Axis position” options under 

“Axis Options” in the “Format axis” menu (using the CTRL-

1 shortcut or using the menu from the ribbon). Here, change 

the “Position Axis” marker from “Between tick marks” to 

“On tick marks”. Notice how the lines now shift out slightly. 
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10. Add your vertical primary axis line (Excel 

2016 leaves it off as default), select the 

axis and add the line under the “Format 

Axis” menu. Doing so, will show some 

overlap between the “gridlines” and the 

axis line. We can do a couple more things 

to line this up just the way we want it. 
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11. We want to extend the data series for each “Line” series 

through row 11. One way to do this is to right-click on the  

graph, select the “Select Data” option, and edit each of the 4 “Line” 

series to extend the data series. 
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Alternatively, you can select the line on the chart and you’ll 

notice that your data are selected in the spreadsheet.  

You can then drag the selection box to extend the data series.  
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This won’t fix the overlap issue, but you’ll notice 

that the group labels are shifted over to the left. 

This is because we now have ten values tagged 

to this secondary horizontal axis. 
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12. We need to now change where the data markers line up with 

the tick marks. Once again, format the secondary x-axis and 

change the “Position Axis” back to “Between tick marks”. 

You’ll notice how the lines shift in slightly so that they don’t overlap 

the vertical axes. 
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13. We also want to turn off the secondary horizontal axis. But 

don’t delete it! You need to turn off the tick marks and labels  

(accomplished in the middle of this same menu) and set the “Line 

Color” to “No line”. 
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14. Repeat the process in Step 13 for the secondary 

vertical axis, remove the gridlines and style the 

rest as you see fit. 
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Final Version with Styling 
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Overlaid Gridlines with a Formula 
In this version of the Overlaid Gridlines chart, I create a stacked 

column chart. Each section of the chart is given a white outline so 

that it appears like there are gridlines. There are fewer steps in this 

approach, but it’s a bit more difficult to get the data set-up. The 

worksheet contains a rather complicated formula that makes this 

approach a bit more flexible: the “Breaker” cell allows you to modify 

where the “gridlines” appear. Use the OverlaidGridlines_Formula tab 

in the Advanced Data Visualizations with Excel 2016 Hands-On.xlsx 

spreadsheet to create the chart. 
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1. Create a stacked column chart from cells C16:M20. These are the cells that contain the formula. 
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2. Notice how the default version of 

the chart plots the columns; we 

want to plot the rows. To do so, 

select the chart and the “Switch 

Row/Column” button in the 

“Design” tab of the ribbon. 
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3. Now it’s just a matter of styling. Change the fill of each 

shape under the “Shape Fill” dropdown in the “Format” 

menu to the same color. Similarly, change the color of 

the “Shape Outline” to white and increase the thickness 

to your desired weight. Of course, delete the existing 

(default) gridlines, legend, etc. 
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4. Repeat for all 5 series. 
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Final Version with Styling 
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Overlaid Gridlines with a Scatterplot 
In this version of the Overlaid Gridlines graph, we’ll combine a 

column chart and a scatterplot. We’ll then add horizontal error bars 

to the scatterplot points to mimic the gridlines. Use the 

OverlaidGridlines_Scatterplot tab in the Advanced Data 

Visualizations with Excel 2016 Hands-On.xlsx spreadsheet to create 

the chart. 
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1. Create a column chart with the “Main Series” data. 

Delete the existing gridlines and chart title. Then, 

right-click on the chart and choose “Select Data” in 

the menu. 
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2. In the next menu, under “Legend Entries (Series)” 

select “Add”. 
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3. We are going to add the scatterplot series, so after choosing 

“Add”, insert the reference to the “Scatter” name in the “Series 

name:” box (cell A8) and (what will become) the y-series 

(B10:B14) in the “Series values:” box. You’ll end up with a paired 

column chart. 
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4. Select the orange (“Scatter”) series and under the “Design” tab 

in the ribbon, select “Change Chart Type”.  

In the resulting menu, change the chart type for the “Scatter” series 

to a scatterplot chart type. 
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5. We have only assigned y-values to the scatterplot series, so we 

now need to give it the x-values. Right-click on the chart and  

choose “Select Data” again. Select “Edit” for the “Scatter” series and 

insert the cell reference for the x-values (A10:A14).  
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6. We now have the scatterplot overlaid with the column chart. 

We now need to add the horizontal error bars. To do so, select 

the “Error Bars” option that appears in the “Chart Elements” 

menu that appears when you select the chart. Now, select the 

“More Options” and menu item and in the resulting “Add Error 

Bars” menu that appears, select the “Scatter” series and select 

“OK”. 
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7. You may notice that Excel will, by default, add 

both vertical and horizontal error bars. The 

default pane is for styling the Vertical Error 

Bars. We don’t need these, so you can press 

delete.  
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8. What we want to do is to style the horizontal 

error bars. Select those error bars (again, by 

right-clicking or using CTRL-1) and you’ll be 

brought to the Horizontal Error Bars formatting 

pane. 
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9. Some changes to make here: Under “Direction” 

select “Both” and under “End Style” select “No 

Cap”. At the bottom, under “Error Amount”, 

select the “Custom” menu and hit the “Specify 

value” button. Here, you’ll be prompted for a 

Positive and Negative Error Value. We’ll insert 

a reference to cell A17 for both values here. Why 

2.4 for the error bar value? The error bars refer 

to the position along the x-axis. We want the 

lines to extend from the scatterplot point just 

beyond the A bar, so that results in two 

“positions” plus a bit more. 
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10. In the “Line Color” tab, you can change the line 

color to a white solid line and in the “Line Style” 

tab, change the line width to 1.5 pt. 
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11. Right-click (or CTRL-1) to format the scatterplot 

points and under “Format Data Series”, select 

the “Marker” Options” tab and then select 

“None” for “Marker Type”. This will hide the 

marker, and all you are left with is the column 

chart with overlaid gridlines. 
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Final Version with Styling 
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Vertical Line 
This tutorial shows you how to add a vertical line to a line chart. This 

could be used to mark an event, a policy change, or some other 

annotation. This approach is superior to drawing a line or shape on 

the graph because it is a part of the graph and can be moved to other 

programs (e.g. PowerPoint) and is linked to data for easier updating 

and replication. Use the VerticalLine tab in the Advanced Data 

Visualizations with Excel 2016 Hands-On.xlsx spreadsheet to create 

the chart. 
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1. Start by making the line graph using cells 

A1:B13. You’ll notice you get two lines. 

Excel assumes that you want to plot the 

values in column A and not use them as x-

axis labels.  
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2. If you select data and remove the “Year” series and remake the 

chart to use A2:A13 as Horizontal Axis labels, 

you’ll get a graph of the Participation series with the Year labeled 

along the axis.
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3. We’ll add the vertical line by adding a scatterplot chart 

to the line chart and then dropping a vertical error bar 

from that point. We start by adding the scatterplot 

point. Right-click on the chart and choose the “Select 

Data” option. (You’ll notice I’ve deleted the title, legend, 

and gridlines here.) 
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4. From there, select “Add” and input the “Series 

name” (cell A15) and the y value of 50 into the 

“Series values” (cell B17) into the box. 
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5. You’ll notice that two things occurred. First, the 

y-axis moved from a maximum of 50 to a 

maximum of 60. Excel will not allow you to put 

a data series at the maximum of the chart, and 

we just added a y-value of 50 to the chart. 

Second, a data marker didn’t appear. This is 

because we have just added a line to the chart, 

but a line needs two points, so nothing appears 

on the chart. To select our newly-added point to 

the chart and convert it to the scatterplot, use 

the dropdown menu in the “Format” tab. The 

“Scatter” series will appear in that dropdown.  
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6. The “Scatter” series is now selected, so while it is selected, we 

will change it to a scatterplot by choosing the “Change Chart 

Type” button in the “Design” tab on the ribbon. 

In that menu, select the “Scatter” option in the dropdown menu next 

to the “Scatter” series and press “OK”. 
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7. We’ve now changed the point to a 

scatterplot, but need to feed it an x-value. 

To do so, right-click on the chart and 

choose “Select Data.” Select the “Scatter” 

series, click “Edit”, and input the x-value 

(cell B16) into the “Series X Values” box.  
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The scatterplot now appears on the chart at the y-value of 

50 and an x-value of 2—note that this is the 2nd position, not 

the year 2001. If, instead of 50, cell B16 was set to 2001, Excel 

would interpret this as the 2,001st position on the horizontal 

axis as illustrated here. Leave the x value at cell B16 on your 

chart. 
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8. Time to add the vertical error bar. Select the “Error Bars” menu 

option in the “Chart Elements” menu that appears when you 

select the chart. In the “Add Error Bars” menu, select the 

“Scatter” series and press “OK”. (You can skip this additional 

menu if you select the “Scatter” series first and then select the 

“Error Bars” option in the “Chart Elements” menu.) In either 

case, select the “More Error Bars Options” in the “Error Bars” 

menu. 
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9. Excel will add both horizontal and vertical error 

bars. Notice that you’ll first be brought to the 

Vertical Error Bars formatting menu. From 

here, make a few changes: Change the 

“Direction” to “Minus”, the “End Style” to “No 

Cap”, and select the “Percentage” option in the 

“Error Amount” menu and type 100 into the box. 

Notice the vertical error bar will drop to the x-

axis.  
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10. Notice that you’re also left with a horizontal 

error bar, which we don’t need, so select it and 

delete. To hide the scatterplot marker, select it 

and select format (right-click or CTRL-1). In the 

“Marker Options” tab, select the option for 

“None”. 
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11. Finally, adjust the maximum of the y-axis to 50 

by formatting the y-axis (again, right-click or 

CTRL-1) and changing the “Maximum” value to 

50. 
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12. As an aside, you can easily add annotation to this line by 

taking the following steps.  

a. First, instead of naming the series “Scatter”, give it the 

name of the annotation you want; for example, “2001 

Policy Passed”. 
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b. Second, select the marker for that series and right-click 

to add data labels.  
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Alternatively, you can use the drop-down 

menu in the top-left of the Format tab to 

directly select the data marker. 
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c. Third, select the data label and right-click 

to format. In the menu, check the box for 

“Series Name” and uncheck the box for “Y 

value”. Format the label as you see fit.  

 

d. You can also accomplish the same goal by 

adding a Data Label to the point. In the 

Data Label formatting menu (which you 

can get to by selecting the Data Label and 

using the CTRL+1 keyboard shortcut), 

selecting the “Value from Cells” option. 

The new menu will allow you to select a 

cell for the label. (Note: this custom Data 

Labels option is not available in the Mac 

OS.) 
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Final Version with Styling. 

 

  



Block Shading (annual-annual) 71 

 

Block Shading (annual-annual) 
This chart type is typically used to mark some period of time behind 

a line or column chart, for example, a forecast period or to mark 

recessions. When the frequencies of the data match up—in this case 

annual and annual—the chart is made quickly and easily. Use the 

BlockShading_Annual tab in the Advanced Data Visualizations with 

Excel 2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. First, notice that if you leave the “Year” 

label in cell A1 and insert a line chart with 

cells A1:C13, Excel will plot the “Year” 

series. 
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2. Deleting the “Year” in cell A1 and then 

inserting a line chart with cells A1:C13 

generates the line chart we’ll start with. 
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3. Select the “Dummy” (orange line) series, and 

under “Change Chart Type” in the “Design” tab 

on the ribbon, change the chart type for that 

series to a clustered column chart using the 

dropdown menu. 
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4. Select the “Dummy” (orange bars) series and 

right-click to format. In the “Series Options” 

tab, change the “Gap Width” to 0%. 

  



Block Shading (annual-annual) 76 

 

5. Format the y-axis (by right-clicking or CTRL-1) 

and change the maximum y-value to 50 (to 

match the “Dummy” series). 
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6. Style as you like by deleting the legend, changing the color 

of the bars, and the number and appearance of the 

gridlines. 
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Final Version with Styling 
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Block Shading (monthly-annual) 
This version of the block shading chart is more complicated than the 

one where the data frequencies line up. In this case—where the one 

series is annual and the shading is monthly (e.g., recessions)—

building the chart requires using the secondary axes. Use the 

BlockShading_Monthly tab in the Advanced Data Visualizations with 

Excel 2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. We start in the same way as the previous chart 

except with the “Year” label in cell A deleted. 

Create a line chart using the data in cells A1:B13. 
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2. Then delete the title (and legend).  
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3. Right-click on the chart and choose “Select Data”.  
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4. We will add the “Recession Dummy” series by 

selecting “Add” in the resulting menu. Then, reference 

cell F1 for the “Series Name” and that series (cells 

F2:F145) for the “Series values”. This will slide the blue 

series far over to the left because Excel now views this 

as a line chart with 144 spaces (corresponding to the 

number of observations in the “Recession Dummy” 

series).  
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5. Select the orange (“Recession Dummy”) series, 

right-click and move that series to the 

“Secondary Axis” by selecting the option in the 

“Series Options” tab.  
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6. Again, select the orange (“Recession Dummy”) 

series, and under “Change Chart Type” in the 

“Design” tab on the ribbon, change the chart 

type for that series to a clustered column chart.  
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7. With a column chart now created—and tagged to the 

secondary axis—we need to “turn on” the secondary horizontal 

axis. To do so, select the chart, and under the “Axis” dropdown  

menu in the “Chart Elements” menu, select the checkbox next to 

“Secondary Horizontal.”  
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8. The orange column chart will seemingly flip to the 

secondary axis, and the blue line will stretch out as it did in 

the first step. 
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9. We want the bars to stretch along the entire 

vertical axis. So, format the secondary vertical 

axis (select it and right-click or CTRL-1), and 

under the “Axis Options” menu, change the 

“Minimum” value to 1 and the “Maximum” value 

to 2 (note that this works because the 

“Recession Dummy” series is set to 1; you can 

use a different number if you want, but these 

minimum/maximum values would then also 

change).  
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10. Format the column chart (by selecting and 

right-clicking or CTRL-1), and under the “Series 

Options” tab, change the “Gap Width” to 0%.  
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11. In that same menu, you can change the colors 

of the bars using the “Fill” section. 
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12. Turn off the secondary horizontal and vertical axes by setting the 

“Line color” to “No line” and “Tick Marks” and “Labels” to 

“None” in the “Axis Options” section of the “Format Axis” menu. 
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Broken Stacked Bars 
Stacked bar or column charts have the disadvantage that it can be 

difficult to compare series that do not lie on the same vertical axis. 

This tutorial shows how to break up a stacked bar chart so that each 

series sits on its own vertical axis. 

The data are set up in a particular way. You’ll notice that I have the 

raw data sitting in the top table in rows 1-6. I’ve made a new data 

table below in rows 9-15. Interspersed between the data are 

“Dummy” data series; each one is equal to 65 minus (denoted in the 

formula using an absolute reference) the neighboring cell. 65 is 

used only because it is larger than the largest data value of 56; 70, 

80, even 57 would also work. Use the BrokenStackedBars tab in the 

Advanced Data Visualizations with Excel 2016 Hands-On.xlsx 

spreadsheet to create the chart. 
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1. Create a stacked bar chart using the data in columns A9:I15. 

(Notice that I deleted the “Group” name in cell A9 before doing 

so; otherwise, Excel will plot the group numbers as a data 

series.) Notice how the chart is grouping the series by columns 

instead of by rows. 
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2. To switch this, select the “Switch Row/Column” button in the 

“Design” tab on the ribbon. 

The chart is now grouped by rows instead of columns. 
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3. We’ve switched the plot, but Excel puts the 6th 

group at the top of the chart and the 1st group at 

the bottom. We’d like to have the order of the 

graph mimic the order of the data in the 

spreadsheet. To do so, format the y-axis (select 

the axis and right-click or hit CTRL-1) and in 

that menu, make two changes: In the “Axis 

Options” tab, check the box next to “Categories 

in reverse order” and change the “Horizontal 

axis crosses:” option to “At maximum category”. 

The first change flips the order of the data, but 

it also moves the x-axis to the top of the chart; 

that’s why the second step is needed. 
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4. We now hide the “Dummy” series by changing their fill to “No Fill” 

using the “Format” menu.  
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5. We now need to change the spacing of the 

vertical gridlines to match the vertical 

alignment of the data bars. Select the horizontal 

axis and right-click or CTRL-1 to format. Change 

the axis to span from 0 (in the “Minimum” 

section) to 260 (in the “Maximum” section), and 

change the “Major Unit” to 65 to match the 

variable used to construct the spacing. 
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If you don’t want that final gridline on the 

chart, you can cheat a bit and change the 

minimum value to 0 and the maximum value 

of the horizontal axis to 259.9.  
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6. You can delete the legend if you like. You can 

also delete just the four “Dummy” series labels 

in the legend by separately selecting and 

deleting each one. You can also delete the x-axis 

because the markers don’t make much sense at 

this point. 
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Vertical Bullet 
A bullet chart contains 5 data series: an observed (actual) value; a 

target value; and three (or more) ranges (e.g., poor, good, and 

excellent). This tutorial shows how to create a vertical bullet chart 

using a stacked bar chart and secondary axes. Use the 

Vertical_Bullet tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. Create a stacked column chart using the data for Region A 

in column B.  
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2. We want these series to be stacked, so you need to use the “Switch Row/Column” button in the “Design” tab. 

  



Vertical Bullet 105 

 

3. We’ll move the Value and Target series to the secondary axis 

by selecting each, right-clicking (or CTRL-1), and selecting 

the “Format Data Series” option at the bottom of the menu. 
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4. In the format menu, select “Secondary Axis” in the “Series Options” menu.  
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5. After you move the first series to the secondary 

axis, you won’t be able to select the other series. 

To select the next series, use the dropdown 

menu in the far top-left section of the “Format” 

tab, then click Format Selection.  
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6. Once both series are moved to the secondary 

axis, format the series to change the “Gap 

Width” to 400% (you’ll only need to do this for 

one of the series).  
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7. We’ll now change the Target series to a 

scatterplot to create the marker. Select the 

Target series and then select the “Change Chart 

Type” menu in the “Design” tab. Use the 

dropdown menu to change the chart type for 

the Target series to “Scatter”.  
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8. Now that it’s a scatterplot, you can format as 

you like. Select the scatterplot point, format by 

right-clicking, and under “Marker Options” of 

the format menu, select the dash under the 

“Built-in” menu. You can also increase the size.  
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9. Alternatively, if you don’t like the look of the 

scatterplot marker, you can change the marker 

to a circle and add a horizontal error bar to the 

point. To do so, select the point, and add an 

error bar using the “Error Bars” option in the 

“Chart Elements” menu. Delete the vertical 

error bar and format the horizontal error bar: 

a. Change the “Direction” to “Both”; 

b. Change the “End Style” to “No Cap”;  

c. Change the “Fixed value” to “0.2”  
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You can also change the appearance of the horizontal 

error bar: 

e. In the “Line Style” menu, change the 

width (I’ve used 2 pt here) 

f. In the “Line Color” menu, change the 

color (I’ve used pink here). 
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10. Be sure to set both y-axes to the same range 

with a minimum and maximum of 0% and 

100%, respectively. 
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11. Recolor and format the different series as needed. To extend 

the series to include all four Regions, simply select the chart 

and drag the blue data box to the right.  
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Horizontal Bullet 
The horizontal bullet chart presents the same data as in the vertical 

version, but this approach is slightly different (you could use the 

same approach for the vertical version, though it’s more difficult to 

apply the vertical version to the horizontal bars). The somewhat 

tricky version of this approach is that you need to be careful with the 

data and where the Target sits in the different ranges. Use the 

Horizontal_Bullet tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. Begin by creating a stacked bar chart using cells A1:B7. 

Notice how the Target* series differs when it sits within the 

“Good” range instead of the “Excellent” range. 
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2. If you select the first option in the “Insert Chart” menu, 

you’ll notice that you get a Clustered Bar Chart instead of a 

Stacked Bar Chart. To change, select the “Switch 

Row/Column” button in the “Design” tab of the ribbon. You 

can also select this chart option directly in the Insert Chart 

menu by selecting the option to the right. 
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3. Move the Value (gold) series to the secondary 

axis by selecting and formatting (either by right-

clicking or CTRL-1). Move the series to the 

“Secondary Axis” under the “Series Options” tab 

and change the “Gap Width” to 400%. 
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4. Fix both sets of horizontal axes to go from 0%-

100%. 
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5. Delete the secondary horizontal axis, legend, and gridlines. 

Format the different series to the desired colors. Notice that 

the “Excellent” series is broken into two groups—to the left 

and right of the “Target” series—so be careful to give those 

two series the same color.  
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6. You can now select the chart and drag the blue data box to 

extend the chart to cover all four Regions. 
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7. Notice how this approach generates a large red box for the 

Target* series in Region D. You need to do some manual 

work here to recolor the that segment. Select that segment 

(not the entire series) and color as needed. Color the 

Excellent-Low segment as your target color. 
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Dot Plot 
The dot plot is a nice alternative to a paired or stacked column/bar 

chart where you want to compare values for different categories. Use 

the DotPlot tab in the Advanced Data Visualizations with Excel 2016 

Hands-On.xlsx spreadsheet to create the chart. 
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1. Creating a Dot Plot in Excel 2016 consists of a 

series of scatterplots. To start, create a 

scatterplot from cells B1:C11. The data are set up 

in such a way to keep the three data series 

(Bottom, Middle, High) next to each other, but 

this also means we need to switch how Excel 

plots the x- and y-series. So, after having 

inserted the scatterplot, right-click on the chart, 

choose “Select Data”, select the “Bottom” series 

and then the “Edit” button. Here, switch the 

data—the “Height” series (B2:B11) should go in 

the “Series Y values:” box and the “Bottom” 

series (C2:C11) should go in the “Series X values:” 

box.  
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2. Add the “Middle” and “High” series by right-

clicking on the chart and choosing the “Select 

Data” option. Select the “Add” option and fill in 

the menu options—for the “Middle” series, fill 

in the “Series name:” box with cell D1; the “Series 

X values:” with cells D2:D11; and the “Series Y 

values:” with cells B2:B11. Repeat for the “High” 

series. (If you haven’t noticed, the “Height” 

series is used for all three series here because it 

doesn’t (and shouldn’t) change.) 
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3. We are going to use Error Bars to add the 

horizontal lines that connect the points. To do 

so, select the orange “Middle” series in the 

chart, and then the “More Options” in the “Error 

Bars” dropdown menu in the “Chart Elements” 

menu that appears when you select the chart.  
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4. You’ll notice that the first set of error bars you are prompted 

to format are the vertical error bars. We don’t need these 

error bars, so you can select and delete them. 
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5. Then, select and format the horizontal error 

bars (by selecting and then right-clicking or 

CTRL-1).  In the menu, choose “No Cap” in the 

“End Style” section of the menu. Then, select the 

button for “Custom” for the “Error Amount”. For 

the “Positive Error Value”, insert the reference 

for the “PosError” series in cells F2:F11. For the 

“Negative Error Value”, insert the reference for 

the “NegError” series in cells G2:G11. 
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6. We now move to setting up the labels so that 

they sit next to the blue points (the “Bottom” 

series). To do so, we can use the “Value From 

Cells” feature in the Data Labels options menu 

(not available in versions prior to Excel 2016). 

Select the “Bottom” series, right-click and select 

the “Add Data Labels” option in the menu.  

  



Dot Plot 132 

 

7. Format the data labels by selecting them and 

right-clicking or using the CTRL+1 keyboard 

shortcut. In the “Label Options” menu, check 

the box next to the “Value From Cells” option. 

In the pop-up box, select the state names from 

cells A2:A11. Uncheck the box next to the “Y 

Value” label and in the “Label Position” section 

of the menu below, select the option next to 

“Left” to move the labels over.  
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8. If you’d rather have the labels further away from the data 

and right-aligned, you can add a new scatterplot series with 

the y-values equal to the “Height” series and the x-values 

equal to a constant (in this example, the number 18 works). 

Then, again, add the data labels using the “Value from Cells” 

option and place them to the left of the points. Now hide 

the markers by right-clicking and changing the “Marker 

Option” to “None”. 
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9. Complete the formatting by changing the shapes and colors 

of the points and deleting gridlines and y-axis, as desired. 
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10. If you want to add arrows to the error bars—as shown in the 

DotPlot_Arrows tab in the Advanced Data Visualizations 

with Excel 2016 Hands-On.xlsx spreadsheet—you can add 

another “Middle” series. From the first “Middle” series, add 

a horizontal error bar that goes to the left (Minus); from the 

new “Middle” series, add a horizontal error bar that goes to 

the right (Plus). Use Left Arrow for the custom negative 

error values and Right Arrow values for the custom positive 

error values. In the “Line Style” tab of the “Format Error 

Bars” menu, select the “Arrow settings” as you see fit.  
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Slope 
The slope chart uses lines to enable comparisons of different 

categories. It is most effective when comparing multiple series with 

only 1-3 data points.  

Use the Slope tab in the Advanced Data Visualizations with Excel 2016 

Hands-On.xlsx spreadsheet to create the chart. 
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1. Start by creating a line chart using the data provided in cells 

A1:C6.  
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2. Excel will create a line chart along the columns here, but we 

want to flip that. Select the chart and then select the “Switch 

Row/Column” button in the “Design” tab on the ribbon.  
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3. It’s now a matter of styling and adding the data 

labels. To get the lines to fill up the entire chart 

space, first delete the legend. Then, format the 

x-axis (select and right-click or CTRL-1): In the 

“Format Axis” menu, select the “On tick marks” 

button at the bottom under the “Axis position” 

section of the menu. This lines up the data 

markers with the tick marks and thus takes up 

the whole chart space. You can also turn off the 

tick marks by selecting “None” in the “Major 

type” dropdown menu under “Tick Marks”, and 

turn off the line in the “Line Color” tab. Press 

“Close” and you can then delete the vertical axis 

and horizontal gridlines. 
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4. Now to add the data markers. Begin by selecting the pink 

line, right-click, and select “Add Data Labels” in the menu. 
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5. This will add a data label to either end of the line. Notice 

how they are both aligned to the right of the point and 

consist of the value of the point. This is fine for the point on 

the right, but for the point on the left, we want the data 

marker to be to the left of the point and to include the state 

name. 
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6. Select the data labels—this will select both—so select the 

left label again so that only that label is selected. 
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7. Right-click and select the “Format Data Label” 

option in the menu. Here, you can check the 

box next to “Series Name” (in addition to the 

“Value” box that is already selected), and select 

the “Left” option under the “Label Position” 

section of the menu. You can also change the 

separator from a comma to a (space) if you 

want. Repeat for the remaining lines. 
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8. The advantage of making these selections through the menu 

is that the labels will all be aligned together. With text 

boxes, you would need to do that alignment manually. You 

can now select the plot area and resize it so that the labels 

fit on the chart. Style chart as desired. 
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Vertical Bar-Scatter 
In this chart, we combine a column chart and a scatterplot for 

comparing values. Use the Bar-Scatter_Vertical tab in the Advanced 

Data Visualizations with Excel 2016 Hands-On.xlsx spreadsheet to 

create the chart 
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1. Create a clustered column chart using the poverty rate data 

in A2-C11. 
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2. Select the Poverty Rate series (the blue bars) 

and change the chart type to a “Line with 

Markers” by using the dropdown menu in the 

“Change Chart Type” menu in the “Design” tab 

of the ribbon. 
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This will give you a marked line on top of the column chart.  
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3. To get rid of the line, format the Poverty Rate 

series by selecting and right-clicking (or CTRL-

1). In the format menu, change the “Line Color” 

to “No line”. That will make the line disappear, 

but the markers will remain.  
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4. Style the chart elements as you like. 
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Horizontal Bar-Scatter 
In this chart, we combine a bar chart and a scatterplot for comparing 

values. Use the Bar-Scatter_Horizontal tab in the Advanced Data 

Visualizations with Excel 2016 Hands-On.xlsx spreadsheet to create 

the chart. 
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1. Create a bar chart using the poverty rate data in A2-C11. 

  



Horizontal Bar-Scatter 156 

 

2. Notice that the order of the data in the chart 

differ from those in the spreadsheet. We want 

those to be the same, especially for this chart. 

Format the y-axis: In the “Format Axis” menu 

(use the CTRL+1 keyboard shortcut), check the 

box next to “Categories in reverse order” and 

change the “Horizontal axis crosses:” option to 

“At maximum category”.  
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3. We are now going to change the poverty rate 

(blue) series to a scatterplot. Select the blue 

series and select the scatterplot option in the 

dropdown menu in the “Change Chart Type” 

menu found under the “Design” tab on the 

ribbon.  
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When you change the series to a scatterplot, the graph is 

going to look very weird. This is because Excel is filling it its 

own values for the x- and y-series.  
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4. We need to now go in and assign them to the 

right position. So, right-click on the chart and 

choose “Select Data.” Select the Poverty Rate 

series and select the “Edit” button. Assign the 

correct series to the x- and y-positions: the x 

series is the Poverty Rate (cells B3:B11), and the 

y series is the “Y-series” data shown in Column 

D (D2:D11). 

 

 The Y-series is created in such a way that the 

points are aligned with the center of the bars. 

This approach works because, by default, Excel 

won’t let you plot data at the maximum of the 

vertical axis, so it will round up from the 

maximum value. We take advantage of this by 

using odd numbers and thus getting the data 

markers to line up with the bars.  
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5. With the data now in the correct order, you can delete the 

y-axis, legend, and format the two series as desired.   
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Lollipop 
A lollipop chart is basically a bar chart except that the end of the bar 

is replaced with a dot (the candy) and the bar itself is replaced with 

a line (the stick, if you will). The lollipop graph reduces a lot of the 

ink on the page and I think helps the reader focus just on the end 

where the data are encoded. Use the Lollipop tab in the Advanced 

Data Visualizations with Excel 2016 Hands-On.xlsx spreadsheet to 

create the chart. 
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1. Create a bar chart with the Spending data using cells A1:B6. 

You’ll notice that Excel sorts the data with Category E at the 

top of the chart. Personally, I want my data to be visualized 

in the same order as it appears in the spreadsheet. So, the 

first step is to re-sort the data so that Category A appears at 

the top of the chart.  
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2. To do so, format the y-axis by selecting it and 

right-clicking or using the CTRL-1 shortcut. In 

the “Format Axis” menu, check the box next to 

“Categories in reverse order” and change the 

“Horizontal axis crosses:” option to “At 

maximum category”. The first change flips the 

order of the data, but it also moves the x-axis to 

the top of the chart; that’s why the second step 

is needed. 
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3. To change this to the lollipop, we’ll use error 

bars. Select the bars in the chart, and select the 

“More Options” option in the “Error Bars” 

section of the “Chart Elements” menu available 

when you select the chart. 
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4. Excel will automatically add horizontal error 

bars to the chart. In the “Horizontal Error Bar” 

menu, change the “Direction” to “Minus”, and 

the “End Style” to “No Cap”. We also want to 

select the “Percentage” option in the “Error 

Amount” area of the menu, and place a 100 in 

the box. This will create a horizontal error bar 

that goes to the left all the way to the y-axis, 

regardless of the data. 
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5. In the “Line” menu (the first option in this 

menu) change the “Begin Arrow type” to the 

circle and increase its size (if you like) in the 

“Begin Arrow size” menu just below. (You can 

also change the color in the “Line Color” menu.) 

(Note: Excel 2016 reversed how ‘begin’ and ‘end’ 

were defined, so if you’ve made this graph in an 

earlier version of Excel and opened it in Excel 

2016, you’ll notice that the circle is in the wrong 

position.) 
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6. Change the fill on the blue bars to “No Fill” by selecting the 

bars and selecting “No Fill” in the “Shape Fill” dropdown 

located in the “Format” menu on the ribbon. 
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Sparklines 
Sparklines are a simple chart type that show small versions (or “small 

multiples”) of graphs. Beginning with Excel 2010, Sparklines became 

a default option, available in the “Insert” tab of the ribbon.  

Use the Sparklines tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. Select where you would like to place your Sparklines (though 

this could be done later too). 
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2. Select the “Line” option in the “Sparklines” 

menu in the “Insert” tab on the ribbon.  
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3. Select your data for the “Data Range:”. 
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4. Hit OK and the Sparklines fill in.  
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5. Using the Sparkline Tools, you can format the color of the 

Sparklines (in the “Sparkline Color” drop down), add markers  

(in the “Show” tab), or even change the chart type to columns (in 

the “Type” tab). 
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Gantt 
The Gantt chart consists of horizontal lines or bars and is typically 

used as a schedule-tracking device to show the duration of different 

values or actions. It’s easy to create a Gantt chart in Excel by simply 

highlighting cells in the spreadsheet, but Glenna Shaw shared a way 

to create a different style of Gantt chart using a line chart with 

markers. 

This Gantt chart has a slightly different look than the typical 

approach. Use the Gantt tab in the Advanced Data Visualizations with 

Excel 2016 Hands-On.xlsx spreadsheet to create the chart.   
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1. The basic Gantt chart using filled-in 

spreadsheet cells is shown here. We are going to 

add data to those cells to plot them in a graph. 

Use the =ROW() formula to place the value of 

each row in the highlighted cell. You could also 

manually type in some values, but the ROW 

formula is a bit faster and easier to update. 
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2. Insert a Line with Markers chart using the data in cells 

A2:H8.   
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3. You’ll notice that the order of the lines in the graph 

don’t match the order of the data in the 

spreadsheet. As we’ve done before, format the y-

axis so the order of the chart matches the order of 

the data by right-clicking the axis (or using the 

CTRL+1 keyboard shortcut) and check the box next 

to “Values in reverse order”. Adjust the axis 

minimum to the lowest row number - 1 and 

maximum to the highest row number + 1 to use the 

full plot area of the chart. 
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4. We can delete some of the unnecessary chart 

elements such as the y-axis, horizontal gridlines, and 

legend.  
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5. We can add vertical gridlines by selecting the x-

axis (now at the top of the chart), and selecting 

the Gridlines option in the Chart Elements 

menu that appears when you select the plus 

button to the right of the chart. 
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6. We are now going to add the labels to the chart. 

If you select the first (top) series, you’ll notice 

that both points are selected. If you click again, 

only the first (left) point is highlighted; right-

click and select Add Data Label. 
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7. Click on the data label twice and right-click (or 

CTRL+1) and make two changes: select only the 

“Series Name” option under Label Options, and 

select the “Left” option in the bottom Label 

Position menu. 
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8. This first label doesn’t look like it moved over to the left, 

but if you select the plot space (not the whole chart, just 

the space inside) you can shift it to the right and the 

label is now lined up to the left of the point. Now repeat 

the process for the other series. 

  



Gantt 186 

 

9. One advantage of Excel 2016 is that you can adjust the 

size of the data label boxes. You may find, for example, 

that the “Design Presentation” label is wrapped on 

two lines. If you want this label to be on just one line, 

you can select the box and select it again—this will 

bring up empty circles around the box; selecting those 

will enable you to adjust the size of the text box. 
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10. You can also change the color of the labels to match 

the colors of your lines. 
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Final Version with Styling 
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Heatmap 
Heatmaps are typically used to show high-frequency data in a 

compact format. You might think of them as a table, but instead of 

showing the actual numbers, the heatmap shows colors.

This visualization is relatively easy to create using Excel’s Conditional 

Formatting menu and then a little trick to hide the numbers. Use the 

Heatmap tab in the Advanced Data Visualizations with Excel 2016 

Hands-On.xlsx spreadsheet to create the chart. 
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1. The basic data for this example consists of 7 

variables for 28 cities, laid out in a simple grid. 

We want to show frequency for each category. 

 

 Gridlines are turned off for this worksheet. 
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2. To add color to the cells using Conditional 

Formatting, select the first category (cells 

B2:B28) and open the “Color Scales” option in 

the Conditional Formatting dropdown found in 

the “Home” tab. Select the “More Rules…” 

option. 

 

 If you wanted to show frequency for the entire 

table instead of by category, you could select 

your data and choose one of Excel’s predefined 

color scale options. 
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3. In the resulting menu, you can select the colors 

you would like to use. It is customary to use 

lighter colors for smaller values, and darker 

colors for larger values. Select the colors in the 

“Color:” dropdown menu. Click OK.  
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The column will now be shaded with the colors 

selected. 
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4. Repeat the process separately for the remaining 

columns.  
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5. The last task is to hide the numbers. You can’t delete them 

because the shading would then disappear, and you can’t 

turn them to white (to match the background) because they 

would then show through the colors. Instead, it’s a small 

formatting trick. Highlight the 7 columns of data and right-

click (or use the CTRL-1 keyboard shortcut) to select 

“Format Cells”. 
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6. Select the “Custom” option at the bottom of the 

“Category:” menu. Type 3 semicolons (;;;) in the 

“Type:” box.  
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7. Press OK. This number format hides the 

numbers; they are still in the cells and can be 

used and manipulated, and the colors remain. 

 

 To make your heat map even easier to 

understand,  

● Average the category numbers by city 

and sort largest to smallest, or 

● Sort by city name, or 

● Sort by state. 
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Final Version with Styling 
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Diverging Bars 
Diverging bar charts are great for showing the differences of negative 

and positive values, such as Strongly Agree to Strongly Disagree. 

Because they align around a central (neutral) value, it can be clearer 

to show these categories diverging from a single midpoint. Use the 

DivergingBars tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. 
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1. Create a stacked bar chart using cells A1:G4. You’ll notice 

that Excel creates the chart along the columns, but we want 

to plot the data along the rows. (You can also select the 

second option on the right when you initially insert the 

chart.)  
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2. To switch this, select the “Switch Row/Column” button in 

the “Design” tab of the ribbon. 

  



Diverging Bars 202 

 

3. The “Dummy” series are just used as fillers, so set the “Fill” 

on those series to “No Fill” using the “Shape Fill” menu in 

the “Format” tab of the ribbon. 
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4. Add data labels to each series by right-clicking and selecting 

the “Add Data Labels…” option from the menu. 
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5. Change the range of the x-axis (again, by right-

clicking or CTRL-1) to .5 for minimum and 2 for 

maximum to use more of the space. You can also 

delete the x-axis because the x-axis labels are 

essentially meaningless. 
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6. Move the Legend to the top of the chart. Remove the 

“Dummy” series labels by individually selecting and deleting 

them.  
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7. Finally, recolor the series as you wish, with different color 

palettes for either side.  
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 If you wish to place the “Group” labels closer to 

the chart, you can label the first “Dummy” 

series; right-click (or CTRL-1) on that series, and 

change the “Label Contains” option to 

“Category Name” and place the “Label Position” 

at the “Inside End”. Then delete the vertical axis. 
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 You can also add a vertical bar at the midpoint 

by adding a scatterplot to the chart. Right-click 

on the chart and choose “Select Data” from the 

menu. Add the new series (“Vertical” in row 23) 

and change to a scatterplot (see some of the 

other tutorials on how to do so). This new 

scatterplot will be pegged to the “Secondary 

Axis”, so you just need to modify the secondary 

horizontal and vertical axes to place the point in 

the correct position. Once positioned, add a 

vertical error bar (see some of the other tutorials 

on how to do so). 
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Final Version with Styling 
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Tile Grid Map 
In a Tile Grid Map, the map areas are given a uniform size and 

shape—usually a square—and are arranged to approximate their 

real-world position. They can be constructed fairly easily in Excel 

after some upfront time with cell formatting and formula building. 

Use the TileGrid tab in the Advanced Data Visualizations with Excel 

2016 Hands-On.xlsx spreadsheet to create the chart. I have included 

a final, formatted version of the Tile Grid Map in the FinalTileGrid 

tab of the file so that you don’t need to do some of the tedious 

retyping.  
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The map is set up by typing the abbreviation of each state name 

in the appropriate cell. I’ve already done this part for you. 
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1. Change to the Page Layout by selecting the “Page Layout” button in the “View” tab of the ribbon. This sets the row and column 

measurements to inches. Size the cells into squares (I set the row 

and column widths to 0.5 inches). Either grab the columns (and 

then rows) and change the width with your mouse, or right-click 

on the columns (and then rows) and select the “Column Width…” 

(or “Row Height…”) option. Change back to Normal view or 

continue to work in Page Layout if preferred. 
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 In the Excel file, the map is located in the left side of the 

worksheet and the data table is located to the right in columns 

O and P. To the right of the data table is another cell that 

calculates the median value of the series (using the MEDIAN 

formula); this measure splits the data into the two groups. 

 

One group is greater than the median and the other group is less than 

or equal to the median. For each state in the map, the cell needs to 

point to the appropriate point in the data column. For example, the 

state cell for Alaska in the map (cell B4) will need to point to cell P2 

(e.g., ‘=P2’). 
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2. To get the state abbreviations in the cell and not 

the data value from the formula, apply a Custom 

Number Format for each state. You need to do 

this one state at a time. For example, select 

Alaska, and right-click (or CTRL-1). In the 

“Format Cells” menu, go to the “Custom” option 

and type in “AK”. This custom label hides the 

number and replaces it with the “AK” 

abbreviation. Repeat for every state. 

  



Tile Grid Map 215 

 

3. For each state in the map, the cell needs to 

point to the appropriate cell in the data 

column on the right. Select the state cell for 

Alaska, in the formula bar type = and then click 

on cell P2 in the data table to map it to Alaska’s 

value. Hit enter. Map all the states to their 

respective values in the data column. 
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4. Excel’s Conditional Formatting menu is used to 

set the colors in the map based on the number 

of groups you want to show (above the median, 

fill the cell with a dark blue; below the median, 

fill it with light blue). To apply it here, select 

the entire map and select the “New Rule” option 

in the Conditional Formatting menu. 
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5. We first add the formula for the blank cells. 

Select the second option in the “New 

Formatting Rule” menu, choose Blanks in the 

Format only cells with: drop down, and format 

those cells (using the “Format” button) to fill 

with a white color. 
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6. We next add the formatting for the data values. Add two 

more conditional formatting rules as follows: 

a. Format only cells that contain cell values less than or 

equal to $S$2 with orange fill and black text 

b. Format only cells that contain cell values greater than 

$S$2 with blue fill and white text 

 

 You can choose different fill and text colors. I’ve used shades 

of blue as my example colors. 
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7. The order of these formulas does matter. You 

want the white (blank) formula to appear first; 

you can do so by selecting the map cells, 

selecting Manage Rules from the Conditional 

Formatting menu, selecting that rule and using 

the up arrow in the formula bar.  
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 You can change the cutoff value from the 

median to something else by changing the 

formula in that cell.  
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8. Finish by formatting the title and legend as desired. 
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Final Version with Styling 
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Marimekko 
The Marimekko chart encodes two variables: one along the height of 

the vertical axis and another along the width of the columns. The 

basic approach of this chart is to create a column chart with 100 

columns, repeating values as necessary. We’ll group the data to make 

it easier to color each series separately instead of having to select and 

recolor each of the 100 columns. This will require working with a 

number of formulas, but it will be more flexible in the end. Use the 

Marimekko tab in the Advanced Data Visualizations with Excel 2016 

Hands-On.xlsx spreadsheet to create the chart. 
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The data for this example consists of 10 items and for each item we have the 

percent purchased (% Purchased). We also have the share of the total sold 

for each item (% of Total), which sums to 100%. For the Marimekko chart, 

we’ll put % Purchased along the vertical axis and % of Total on the 

horizontal axis.  

The data are found in columns B and C; the rest of the worksheet is 

constructed to build the graph, and much of it repeats so that we can use 

the VLOOKUP formula. This version of the Marimekko uses rounded data 

values; if your data have decimals, simply multiply everything by 10 or 100 

and use 1,000 or 10,000 columns in the chart. 
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Setting up the Data  

 COLUMN 1 [E] 

Create a new column for the % of Total variable, but change it 

from a percentage to an integer. You could copy and paste the 

original data and change the format of the new cells (select the 

cells and right-click or use the CTRL-1 keyboard shortcut), or use 

a formula [E5=C5*100] so that the data can be easily updated.  

COLUMN 2 [F] 

Create a Count variable that denotes the cumulative count of each 

item. We’ll start with the number 1, which is hard-coded in cell F3. 

A simple formula [F6=F5+E5, F7=F6+E6, …] sets the number of 

cells for each value. Thus, the first Item will ultimately be 

represented by the 1st through 10th columns; the second Item starts 

with the 11th column; and so on. 

COLUMN 3 [G] 

Repeat the % Purchased series; again, the formula [G5=B5] will 

make it easier to update if the data change. 
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COLUMN 4 [I] 

Repeat the Count variable [I5=F5]. (Note: Column H is left blank 

to simply separate the groups of data.) 

Column 5 [J] 

Simple Item # here, counting up from 1 to 10. 

Column 6 [L] 

Repeat the Item # series [L5=J5]. (Note: Column K is left blank to 

simply separate the groups of data.) 

Column 7 [M] 

Repeat the % Purchased variable [M5=G5] 
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Column 8 [O] 

You can think of starting to build the chart by setting up this 

column first. This Counter simply counts from 1 to 100. Don’t type 

this manually—type a “1” in cell O4 and then the formula 

[O5=O4+1] in the cell just below and drag it down to row 103. 

[Column 9 [P] 

We’ll use a VLOOKUP formula to bring over the data for the chart. 

In cell P4, we put =VLOOKUP(O4,$I$5:$J$14,2,1) and drag it down 

to row 103. 

[Column 10 [Q] 

In cell Q4, we put =VLOOKUP(O4,$F$5:$G$14,2,1) and drag it 

down to row 103. 
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How the Formula Works 

 
=VLOOKUP(O4, $F$5:$G$14, 2, 1) 

 

=VLOOKUP(O4, 

This is the thing we look up. We are going to match each entry in this 

Counter series to another look-up table to pull out corresponding 

values.  

$F$5:$G$14 

We’re going to query the data we created earlier that consists of the 

Count and Item # data in columns I and J. VLOOKUP matches the 

first argument in the VLOOKUP formula to the first column in the I-

J table, which is why we needed to order things the way we did in the 

first set of steps. (The dollar signs ($) act as the absolute references 

so that we can copy and paste this formula without changing the cell 

references.)  

2 

This corresponds to the column number we want to extract, so this 

refers to the Item # data in column J. 

1 

This is the “range_lookup” value and tells Excel we want an 

“approximate match” of the value in cell O3 instead of an “exact 

match.” It’s good practice to specify this argument whenever you use 

VLOOKUP. This is the key part of the formula for this exercise. What 

the approximate match does, is only fill in those cells for which the 

lookup value (in column I) does not exceed the lookup reference (the 

Counter series). Thus, you’ll notice how the values in column P equal 

the first item number for the first 10 entries and then, starting on the 

11th entry, starts with the second item number. 

In sum, this VLOOKUP queries the Counter series and pulls out the 

Item # from Column J to denote each series that will populate the 

chart. 
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COLUMNS 11-20 [R-AA] 

We’re going to create 10 different data series (one for each Item) so 

that we can add them all to one chart and then color each by simply 

grabbing the entire group. The numbers at the top of the series (in 

Row 2) are important here and correspond to each Item Number. This 

formula is a little complicated, but once it’s inserted into the first 

column, we can just drag it horizontally and vertically. 

So, in cell Q3, we have 

=IF($P4=R$3,VLOOKUP($P4,$L$5:$M$14,2,1),0) 
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Let’s Break It Down Again 

 

=IF($P4=R$3, VLOOKUP($P4,$L$5:$M$14,2,1), 0) 
 

=IF($P4=R$3, 

To start, the IF statement evaluates the first argument, here $P4=R$3. 

We’re simply comparing the Item Number entered in the second row 

to how many times each series will repeat in Column P. Notice the 

strategic use of the absolute/relative reference “$” symbol; we use the 

references so the cell specifications don’t move when we drag the 

formula across the worksheet. 

VLOOKUP($P4,$L$5:$M$14,2,1), 

If the first argument is True, the second argument is evaluated and 

placed in the cell. That argument uses another VLOOKUP: Here, the 

first argument ($P3) looks up the Item # from column P in the last set 

of data placed in columns L and M, specified in the second argument 

by [$L$5:$M$14]. The third argument in the VLOOKUP (the number 

2) looks in the second column (column M). The final piece of the 

VLOOKUP (the number 1) specifies an approximate match. The 

VLOOKUP formula pulls out the % Purchased variable, which is the 

thing we’re going to plot. 

0) 

If the first argument is False, the formula places a 0 in the cell, as 

specified by the “0” at the end of the IF statement. As an example, for 

the first Item [Column P], the first 10 rows fill with 45% and the 

remainder fills with 0%; for the second Item, the first 10 rows are set 

to 0%, the next 18 rows are 38%, and the remaining 72 rows are 0%. 

Dragging this formula across and down will give you blocks of 

numbers that repeat the % Purchased values corresponding to their 

shares of the total. 

You could also use the formula 

=IF($P4=R$3,VLOOKUP(R$3,$P$4:$Q$103,2,1),0) which uses the data 

we set up in Columns 9 and 10 instead of Columns 6 and 7. Both 

formulas will return the same values. 

  



Marimekko 231 

 

[Column 21 [AB] 

In this example, we’ll place x-axis labels at every 10% increment. 

To do so, we’ll create a custom x-axis series to add to the chart. 

Here’s the formula: =IF(INT(O5/10)*10=O5,O5/100,""). This 

formula uses the INT function to round the number down to the 

nearest integer. If we divide the Counter series (in column O) by 

10 and round down to the nearest integer [INT(O5/10)] and then 

multiply by 10, we get whole numbers. If those whole numbers 

equal increments of ten (which works because we divided by 10 in 

the INT formula), we set the cell value to that percentage; if not, 

the formula returns return an empty cell, denoted by the “ ” in the 

IF statement. If you enter this formula in cell AB4 and drag it down 

the column, you’ll only see “10%”, “20%”, “30%”, etc. show up in 

the cells. 
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Create the Chart 

1. We now create a column chart using the data in 

columns R4-AA103. To close the gaps between 

the columns, right-click on the series and 

change the Gap Width to 0% and the Series 

Overlap to 100%.  
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2. You can now easily change the color of each series (i.e., each 

Item) by selecting it on the chart and using the “Fill” options 

in the “Format” menu. 
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3. To add the x-axis labels to the chart, right-click on your 

chart and choose Select Data and select Column AB4:AB103 

as the Horizontal (Category) Axis Labels.  
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4. Now go back to the chart and format the x-axis 

by right-clicking (or CTRL-1). Change the 

Interval between tick marks from 1 to 10. You’ll 

also need to select the Specify interval unit 

option in the Interval between labels menu, and 

Excel should fill in the 1 for you. Format chart as 

desired. 
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Final Version with Styling 
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Data Visualization Books 

If you wish to learn more about data visualization, there exists a large 

and growing set of books that will help you dive deeper into best 

practices and strategies to effectively create and present your data. 

More books, blogs, and other resources can be found at 

PolicyViz.com.  

Alberto Cairo. Cairo is a journalism professor, so his books primarily 

focus on data visualizations geared towards a wide audience. His first 

two books on data visualization, The Functional Art and The Truthful 

Art, cover fundamental overviews of data, some statistics, and data 

visualization.  

Jorge Camões. All of the visuals in Data at Work are built in Excel 

(though it is not a step-by-step guide) and covers covers a wide range 

of data visualization principles and strategies. 

Stephen Few. Few’s Show Me the Numbers and Now You See It: Simple 

Visualization Techniques for Quantitative Analysis demonstrate how 

to present data effectively and strategically.  

Andy Kirk. Kirk’s Data Visualisation: A Handbook for Data Driven 

Design is one of the few books that offers a system to conceptualize 

and develop data visualizations. 

Cole Nussbaumer Knaflic. Knaflic’s Storytelling with Data (she has a 

blog of the same name) is a great introductory treatment to data 

visualization, and how to pair text with graphs to lead your reader or 

user to a conclusion.  

Naomi Robbins. A succinct guide to creating effective graphs, 

Robbins’ Creating More Effective Graphs gives you the basic 

knowledge and techniques required to choose and create appropriate 

graphs for a broad range of applications.  

Jonathan Schwabish. Designed for presenters of scholarly or data-

intensive content, Better Presentations: A Guide for Scholars, 

Researchers, and Wonks details essential strategies for developing 

clear, sophisticated, and visually captivating presentations.  

Edward Tufte. Author of four books, Tufte’s books are sometimes 

viewed as classics in the field of data visualization. His The Visual 

Display of Quantitative Information is especially relevant to 

introductory data visualization with different examples and 

techniques.  

Dona Wong. Wong dedicates individual pages in her book, The Wall 

Street Journal Guide to Information Graphics, to specific graph types, 

and how and why to choose the best chart to fit the data.

http://policyviz.com/
http://www.amazon.com/gp/product/0321834739/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0321834739&linkCode=as2&tag=poli03-20&linkId=QPHNSACFRQLJHTRU
http://www.amazon.com/gp/product/0321934075/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0321934075&linkCode=as2&tag=poli03-20&linkId=3YBA3Z5E4UB4RCQO
http://www.amazon.com/gp/product/0321934075/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0321934075&linkCode=as2&tag=poli03-20&linkId=3YBA3Z5E4UB4RCQO
http://www.amazon.com/gp/product/0134268636/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0134268636&linkCode=as2&tag=poli03-20&linkId=DZCODLJGH5TSZKQL
http://www.amazon.com/gp/product/0970601972/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0970601972&linkCode=as2&tag=poli03-20&linkId=CUJR6RVFUIN5YHBV
http://www.amazon.com/gp/product/0970601980/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0970601980&linkCode=as2&tag=poli03-20&linkId=MBLYQIFAID2VJPLV
http://www.amazon.com/gp/product/0970601980/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0970601980&linkCode=as2&tag=poli03-20&linkId=MBLYQIFAID2VJPLV
http://amzn.to/2kHnU22
http://amzn.to/2kHnU22
http://amzn.to/2kHtAsH
https://www.amazon.com/gp/product/0985911123/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0985911123&linkCode=as2&tag=poli03-20&linkId=CO7APXAAABGMJ5JH
http://amzn.to/2amORq1
http://amzn.to/2amORq1
http://www.amazon.com/gp/product/0961392142/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0961392142&linkCode=as2&tag=poli03-20&linkId=DLGQPGEET27BE5ZS
http://www.amazon.com/gp/product/0961392142/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0961392142&linkCode=as2&tag=poli03-20&linkId=DLGQPGEET27BE5ZS
http://www.amazon.com/gp/product/0393347281/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0393347281&linkCode=as2&tag=poli03-20&linkId=WIMD7TMHSJSFJRVV
http://www.amazon.com/gp/product/0393347281/ref=as_li_qf_sp_asin_il_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0393347281&linkCode=as2&tag=poli03-20&linkId=WIMD7TMHSJSFJRVV
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